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Important Notice Due to the nature of wireless communications, transmission 
and reception of data can never be guaranteed. Data may be 
delayed, corrupted (i.e., have errors) or be totally lost. 
Although significant delays or losses of data are rare when 
wireless devices such as the Sierra Wireless modem are used in 
a normal manner with a well‐constructed network, the Sierra 
Wireless modem should not be used in situations where failure 
to transmit or receive data could result in damage of any kind 
to the user or any other party, including but not limited to 
personal injury, death, or loss of property. Sierra Wireless 
accepts no responsibility for damages of any kind resulting 
from delays or errors in data transmitted or received using the 
Sierra Wireless modem, or for failure of the Sierra Wireless 
modem to transmit or receive such data.

Safety and Hazards Do not operate the Sierra Wireless modem:
• In areas where blasting is in progress
• Where explosive atmospheres may be present
• Near medical equipment
• Near life support equipment, or any equipment that may 

be susceptible to any form of radio interference. In such 
areas, the Sierra Wireless modem MUST BE POWERED 
OFF. The Sierra Wireless modem can transmit signals that 
could interfere with this equipment.

Do not operate the Sierra Wireless modem in any aircraft, 
whether the aircraft is on the ground or in flight. In aircraft, the 
Sierra Wireless modem MUST BE POWERED OFF. When 
operating, the Sierra Wireless modem can transmit signals that 
could interfere with various onboard systems.

Note: Some airlines may permit the use of cellular phones while the 
aircraft is on the ground and the door is open. The Sierra Wireless  
modem may be used at this time.

The driver or operator of any vehicle should not operate the 
Sierra Wireless modem while in control of a vehicle. Doing so 
will detract from the driver or operatorʹs control and operation 
of that vehicle. In some states and provinces, operating such 
communications devices while in control of a vehicle is an 
offence.
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Limitation of 
Liability

The information in this manual is subject to change without 
notice and does not represent a commitment on the part of 
Sierra Wireless. SIERRA WIRELESS AND ITS AFFILIATES 
SPECIFICALLY DISCLAIM LIABILITY FOR ANY AND ALL 
DIRECT, INDIRECT, SPECIAL, GENERAL, INCIDENTAL, 
CONSEQUENTIAL, PUNITIVE OR EXEMPLARY DAMAGES 
INCLUDING, BUT NOT LIMITED TO, LOSS OF PROFITS OR 
REVENUE OR ANTICIPATED PROFITS OR REVENUE 
ARISING OUT OF THE USE OR INABILITY TO USE ANY 
SIERRA WIRELESS PRODUCT, EVEN IF SIERRA WIRELESS 
AND/OR ITS AFFILIATES HAS BEEN ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGES OR THEY ARE 
FORESEEABLE OR FOR CLAIMS BY ANY THIRD PARTY.

Notwithstanding the foregoing, in no event shall Sierra 
Wireless and/or its affiliates aggregate liability arising under or 
in connection with the Sierra Wireless product, regardless of 
the number of events, occurrences, or claims giving rise to 
liability, be in excess of the price paid by the purchaser for the 
Sierra Wireless product.

Patents Portions of this product may be covered by some or all of the 
following US patents:
5,515,013 5,629,960 5,845,216 5,847,553 5,878,234
5,890,057 5,929,815 6,169,884 6,191,741 6,199,168
6,339,405 6,359,591 6,400,336 6,516,204 6,561,851
6,643,501 6,653,979 6,697,030 6,785,830 6,845,249
6,847,830 6,876,697 6,879,585 6,886,049 6,968,171
6,985,757 7,023,878, 7,053,843 7,106,569 7,145,267
7,200,512 7,287,162 7,295,171 D442,170 D459,303
D559,256 D560,911
and other patents pending.

This product includes technology licensed from 
QUALCOMM® 3G.

Manufactured or sold by Sierra Wireless Inc. or its Licensees 
under one or more patents licensed from InterDigital Group.

Copyright ©2009 Sierra Wireless. All rights reserved.
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Trademarks AirCard and “Heart of the Wireless Machine” are registered 
trademarks of Sierra Wireless. Watcher is a trademark of Sierra 
Wireless, registered in the European Community.
Sierra Wireless, the Sierra Wireless logo, TRU‐Install, 
TRU‐Locate, and the red wave design are trademarks of Sierra 
Wireless.

Windows® is a registered trademark of Microsoft Corporation.

PC Card and ExpressCard are trademarks of PCMCIA.

QUALCOMM® is a registered trademark of QUALCOMM 
Incorporated. gpsOne is a trademark of QUALCOMM 
Incorporated.

InstallShield® is a registered trademark of Macrovision Corpo‐
ration in the United States of America and/or other countries.

Other trademarks are the property of the respective owners.

Contact 
Information

Additional 
information and 
updates

For up‐to‐date product descriptions, documentation, appli‐
cation notes, firmware upgrades, troubleshooting tips, and 
press releases, visit www.sierrawireless.com.

Sales Desk: Phone: 1-604-232-1488

Hours: 8:00 AM to 5:00 PM Pacific Time

E-mail: sales@sierrawireless.com

Post: Sierra Wireless
13811 Wireless Way
Richmond, BC
Canada            V6V 3A4

Fax: 1-604-231-1109

Web: www.sierrawireless.com

mailto:sales@sierrawireless.com
http://www.sierrawireless.com
http://www.sierrawireless.com
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11: Introducing the AirCard 402 
modem
• Welcome
• Feature summary
• Package contents
• System components
• Care and maintenance 

of your modem

Note: This document applies to you, only if your wireless card is the 
AirCard 402 modem from Sierra Wireless.

Welcome
The Sierra Wireless AirCard 402 modem is a dual‐band 
wireless ExpressCard/PC Card modem for cellular and PCS 
networks, and the GPS frequency band. The modem enhances 
the functionality of your mobile computing device by adding 
2‐way messaging and high‐speed mobile data in extended 
areas, compared to wireless local area networks.

This modem allows you to do the following (subject to feature 
availability), without using a wireline phone or network:
• Connect to the Internet, VPN and corporate networks
• Send and receive large e‐mail messages
• Send and receive SMS messages
• Use location‐based services
• Conduct video‐conferencing
• Access streaming, real‐time media
• Play games online

Note: You can view this guide online or print it to keep on hand. If 
you're viewing it online, simply click a topic in the Table of Contents, or 
a page number in the Index, or any page reference or section 
reference. (Most text that is blue is a clickable link.) The PDF 
automatically displays the appropriate page.
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Feature summary

Note: For step-by-step instruc-
tions to access features of the 
modem, consult the online help 
available with the Watcher® 
software (page 34).

The ExpressCard/PC Card is designed to provide a wide range 
of capabilities using CDMA network technology. Implemen‐
tation of these features depends on the particular service 
provider and account features you have chosen.

Some features described in this manual may not be supported 
by your service provider or may not be available with your 
network account. For details of the services and accounts 
available, contact your service provider.

Wireless modem

Once installed and configured, the modem can connect to the 
CDMA network automatically. You just insert the modem, 
allow Watcher to autolaunch and authenticate your account on 
the network, then launch your Internet browser (which you 
can also configure in Watcher to launch automatically)—you’re 
online!

Alternatively, you can make a high‐speed data connection 
without running Watcher—simply by launching whatever 
application you want to use (such as your web browser or 
e‐mail application). For details, see the online help topic 
“Autoconnect behaviour”.

The modem also allows you to dial up a modem (such as a 
corporate server).

TRU-Install

TRU‐Install™ is a Sierra Wireless feature that installs the 
necessary software and drivers the first time you insert the 
modem into your computer. An installation CD is not 
required.

TRU-Locate

With TRU‐Locate™, you can use location‐based services (GPS) 
to query, for example, the network for information on points of 
interest (POI) that are near your current location, or display 
driving instructions.

Note: TRU-Locate is subject to feature availability.
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Your modem requires an unobstructed view of GPS satellites 
(in the sky), and, like any other GPS device, might not perform 
well within forested areas or near tall buildings.

Depending on your account, you may be charged for each 
position fix or after you have performed a certain number of 
fixes. For details, contact your service provider.

Depending on the mechanism that the network and your 
modem use to obtain location information, GPS may not be 
supported:
• If Network Mode is set to “EVDO Only”
• If youʹre roaming
• If you do not have network coverage
• Due to other reasons.

If you’re having problems using GPS, contact your service 
provider.

CDMA 3G services

The modem operates over a type of wireless network called 
CDMA (Code Division Multiple Access).

CDMA 3G technology provides a variety of connectivity 
features, depending on your service provider and account:
• 1x‐EVDO Rev. A supports Internet connections with data 

rates up to 3.1 Mbps (downlink from the network) and 
1.8 Mbps (uplink to the network). Average data rates are 
450‐800 Kbps (downlink from the network) and 
300‐400 Kbps (uplink to the network). Actual speed 
depends on the network conditions.

• 1x‐EVDO Rev. 0 supports Internet connections with data 
rates up to 2.4 Mbps (downlink from the network) and 
153 Kbps (uplink to the network). Average data rates are 
400‐700 Kbps (downlink from the network) and 
40‐80 Kbps (uplink to the network). Actual speed depends 
on the network conditions.

• 1X supports Internet connections with data rates up to 
153 Kbps. Actual speed depends on the network condi‐
tions.

Once the connection is established, you can open your browser 
and connect to any web site that is accessible through the 
Internet, or access other Internet services (such as e‐mail).

The connection is “active” when data transmission is 
occurring. If data transmission stops for a period of time 
(determined by the network), the connection becomes 
dormant.
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• Circuit switched (dial‐up) data, using the earlier CDMA 
IS‐95 specification, supports data connections to any dial‐
in service at rates up to 14.4 Kbps.

• QNC (Quick Net Connect) provides a simplified way to 
dial into an Internet connection (using circuit switched 
data) where 3G (1xEV‐DO or 1X) high‐speed packet 
service is not available.

• SMS (Short Message Service) allows you to send and 
receive short text messages using the modem.

Additional features of the modem

Beyond the features of the CDMA network, the modem 
provides additional software features:
• PIN security code to protect your modem and account 

from unauthorized use.
• A wizard to assist with activating your CDMA account.
• Sound options to customize ringtones for SMS messages.
• A Call Log to track outgoing calls and determine the 

amount of data transferred.

Package contents
Your package contains the following items:
• AirCard 402 modem
• Quick Start Guide

To install the modem drivers and software, you do not need an 
installation CD. Your modem uses the Sierra Wireless 
TRU‐Install feature. The drivers and software are installed 
when you insert the modem into your computer and go 
through the software installation; an installation CD is not 
required.

System components
Your modem is just one part of a system designed to provide 
you with a wide range of communication features. Every 
component of the system is needed to enable these capabilities.
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Your host computing device

Your notebook or desktop computer hosts the modem 
hardware and runs the communication software: your web 
browser or e‐mail application, and Watcher—the enabling 
software for the modem.

You may also have other software on your computer that can 
be used wirelessly with the modem, such as: file transfer appli‐
cations (FTP), chat or instant messaging, a VPN (Virtual 
Private Network) client, client software for a corporate server 
application.

The ExpressCard/PC Card modem

The modem provides your computer with a connection to the 
CDMA wireless network.

The modem fits into a standard ExpressCard/34 or 
ExpressCard/54 slot or, when used in the card adapter, into a 
PC Card slot available on most notebook and desktop 
computers.

Every CDMA network operates on one of three radio 
frequency bands. As a dual‐band product, the modem 
operates on two of these bands (see page 38), providing a wide 
coverage area.

The modem drivers and enabling 
software

The modem drivers and enabling software (Watcher) monitor 
and manage your wireless connections.

Your modem uses the Sierra Wireless TRU‐Install feature—the 
drivers and software are installed when you insert the modem 
into your computer.

The device driver software enables the modem to work with 
your computer’s operating system.

Using the Watcher software, you can manage the modem and 
monitor your connections.

For step‐by‐step instructions to access features of Watcher, use 
the application’s online help.
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CDMA service provider account

Companies that operate CDMA networks and provide access 
to these networks are called service providers. To use the 
modem, you must have an account with a CDMA service 
provider.

Note: You can use the Lock 
Modem feature to prevent others 
from using your account, should 
your modem be stolen.

Each service provider has its own pricing options. There may 
be flat rate accounts, which provide you a maximum number 
of minutes of network usage for a fixed monthly fee. There 
may be accounts for which you are charged for network usage 
by the minute or by the amount of data transmitted.

Your account may include a variety of other services such as 
SMS messaging or location‐based services.

Each modem has been provisioned at the factory for use with a 
particular service provider. This sets the modem to use 
particular radio channels and enables services specific for that 
provider.

The process of setting up your account is called activation. 
Activation involves action by the service provider and configu‐
ration of the modem.

The procedure to configure (activate) your modem is covered 
in “Activation” on page 25.

The CDMA wireless network

Note: More information about 
CDMA networks is available on 
the CDMA Development Group 
web site, www.cdg.org.

This is the worldwide infrastructure providing the radio 
coverage that allows you to stay connected. Made up of radio 
towers and a variety of network switches, routers, and servers, 
the network is an interconnection of many service providers.

Note: Most service providers 
have coverage maps on their 
web sites.

There are CDMA networks that operate in the frequency bands 
supported by the modem throughout North America and 
parts of Latin America, Asia, and New Zealand. However, 
each service provider operates a network that covers a limited 
geographical area within the overall CDMA coverage area.

Note: The fee for service is 
usually higher when you are 
roaming (connecting to a 
network other than the one 
belonging to your service 
provider).

Most service providers have “roaming” agreements with other 
service providers, so that they can offer service outside of the 
coverage area of their own networks. For example, assuming 
you live in Vancouver (Canada), and travel frequently to 
Seattle (United States), you can obtain an account with a 
Vancouver service provider that has a roaming agreement with 
a service provider in Seattle. You would then have local service 
in Vancouver, and roaming service in Seattle.

http://www.cdg.org
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Care and maintenance of your 
modem
As with any electronic device, the modem must be handled 
with care to ensure reliable operation. Follow these guidelines 
in using and storing the modem:
• Do not apply adhesive labels to the modem or card 

adapter. This may cause the modem or card adapter to 
become jammed inside the card slot.

• The modem should fit easily into your ExpressCard/
PC Card slot. Forcing the modem into a slot may damage 
connector pins.

• When inserting or removing the modem, always grip it by 
the sides rather than the top (see the drawings on page 23).

• Protect the card from liquids, dust, and excessive heat.
• When not installed in your computer, store the modem in 

its carry case
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22: Getting Started
• The AirCard 402 

software
• Account activation and 

configuration

Before you can begin using the modem, you must:
1. Insert the modem, to install the enabling software and 

drivers.
2. Activate an account and configure the modem to use your 

account (unless the modem has been pre‐activated).

This section provides an overview of this process.

The AirCard 402 software
The modem comes with the following software:
• Watcher application that you use to manage the modem 

and monitor your connections on your computer
• The driver software that provides the interface between 

the modem and your Windows operating system

Detailed instructions for installing the modem and its software 
are provided in “Installation” on page 19.

Account activation and 
configuration
To use the modem, you must have an account with a CDMA 
service provider. The process of setting up an account is called 
activation.

If you purchased the modem directly from a service provider, 
you may already have an account; your modem may be pre‐
activated.

Otherwise, run the Watcher software and the Activation 
Wizard, which guides you through the activation and configu‐
ration process. (Depending on your configuration, the software 
and the activation procedure may start automatically.)

Configuring the modem involves setting the phone number 
assigned by your service provider and may involve entering 
other network parameters and settings such as a user name 
and password to access services.
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Your service provider may need to know:
• The billing information to use to collect payment for your 

network usage.
• The ESN (Electronic Serial Number) or MEID (Mobile 

Equipment Identifier) assigned to your modem during the 
manufacturing process. (The ESN or MEID is printed on a 
label on the modem and can be displayed in the software.) 
This number is used to help authenticate your account 
when you connect for service.

You require from your service provider:
• An activation code that gives you access to configure the 

account.
• A phone number for your modem.
• Additional information specific to your service provider 

such as:
· A user ID (username) and password to authenticate your 
network connection.

· A SID (System IDentifier) that identifies your home 
network area and is used together with your phone 
number to determine if you are “home” or “roaming”.
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33: Installation
• System requirements
• Installing the modem 

and software
• Removing the modem
• Attaching an external 

antenna

This chapter guides you through the steps necessary to install 
the modem on a notebook or desktop computer.

The basic steps are:
1. Insert the modem into the ExpressCard/PC Card slot to 

install the modem drivers and software.
2. If the modem has not been pre‐activated, use the 

Activation Wizard to configure the modem (as described 
in “Activation” on page 25).

Before you begin the installation process, ensure your 
computer meets the requirements described below.

System requirements
The modem is supported on notebook and desktop computers 
running:
• Windows Vista
• Windows XP (Home and Professional versions) with 

Service Pack 2 or later
• Windows 2000 with Service Pack 4 and Update Rollup 1

To install the modem, you require one of the following slots:
• ExpressCard/34
• ExpressCard/54
• Type II PC Card slot.

Installing the modem and 
software

Note: If you’re running Windows XP, you may require administrative 
privileges, depending on the Windows XP installation.
If you’re running Windows Vista or Windows 2000, you must be 
logged in with administrative privileges to install the modem software.
If you’re running Windows 2000, your computer might be restarted, as 
part of the installation process; save any open documents.
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 To install Watcher and the modem drivers:
1. If your computer has a WiFi or Bluetooth adapter, turn it 

off. (For instructions, see the user guide or online Help of 
your computer).

Note: Do not forcefully insert the 
modem. This may damage the 
connector pins.

2. If your computer has a PC Card slot, grip both sides of the 
card adapter and insert the modem and card adapter into 
your computer (modem label facing up); proceed to step 6 
on page 21.

If your computer has an ExpressCard slot, remove the 
modem from the card adapter, as described below.

3. Slide and hold the locking tab in the indicated direction.
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4. Holding the locking tab, use your other hand to free the 
modem from the card adapter.

Note: Do not forcefully insert the 
modem. This may damage the 
connector pins.

5. Gripping both sides of the modem, insert it into your 
computer (modem label facing up).

6. If the TRU‐Install window is not displayed, in Windows 

Explorer browse to the   entry (under My 
Computer), then browse to the Win folder and run Setup.exe; 
alternatively, if you’re running Windows Vista and the 
AutoPlay window is displayed, click Run setup.exe.

7. In the TRU‐Install window, click OK.
8. In the “Welcome to the InstallShield Wizard” window, 

select Install to launch the InstallShield® Wizard.
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9. If the Open With... window appears, cancel the installation 
(your computer is missing some files required for the 
installation). Search for Instmsiw.exe (if you’re running 
Windows 2000) among the downloads at 
www.microsoft.com. Install the file on your computer, 
remove the modem from your computer, then rerun the 
installation.

10. If the Ikernel Application Error window appears:
a) Cancel the installation.
b) Download the file:

http://support.installshield.com/kb/files/Q108312/
ikernelupdate.exe.

c) Install the file on your computer, remove the modem 
from your computer (see page 23), then rerun the  
installation.

11. Use the Next and Back buttons to navigate through the 
wizard noting the following:
· To proceed with the installation, you must click I accept 

the terms in the license agreement to indicate your accep‐
tance of the terms of the license agreement.

Windows detects the modem and installs the drivers for it. 
This may take a few minutes. Once completed, the system 
tray may display the message “Your devices are ready to 
use“ or “Your new hardware is installed and ready to use”:

12. If you are prompted to restart your computer:
a) Save any open documents.
b) Select the option to restart your computer.
c) Wait until your computer restarts and Windows is ready.

13. When you are notified that the installation is complete, 
click Finish.

14. If Watcher has not started automatically, start it: double‐
click the Watcher icon   on your desktop.

15. Proceed to configure the modem to use your account (if it 
was not pre‐activated). See “Activation” on page 25.

http://www.microsoft.com
http://support.installshield.com/kb/files/Q108312/ikernelupdate.exe.
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Removing the modem
To remove the modem:
1. Close Watcher if it is open.
2. If you’re running Windows 2000, click the Unplug or Eject 

Hardware icon in the system tray, and click the entry 
for NEC PCI to USB Open Host Controller or Standard 
Enhanced PCI to USB Host Controller. If a dialog box appears 
notifying you that it is safe to remove the device, click OK.

3. Use the ejector (located on your computer, next to the 
ExpressCard/PC Card slot) to remove the modem from the 
slot. Pull the modem out of the slot by gripping both sides 
of the modem and pulling the modem straight out.

Attaching an external antenna
You can improve the signal strength by attaching an external 
antenna with a TS9 connector (sold separately). The recom‐
mended antenna is the 6‐band blade antenna with TS9 
connector, available from www.sierrawireless.com (part number 
6000342).

Caution: Use of other antennas may violate FCC requirements.

To attach the external antenna:
1. If the modem is inserted in your computer, remove it.
2. Gently flip open the tab on the side of the modem.
3. Hold the antenna cable by the connector (end) part, and 

carefully insert the connector part of the cable into the 
corresponding connector on the modem.

4. Reinsert the modem into your computer.

Correct Incorrect

http://www.sierrawireless.com
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44: Activation
• Account configuration 

procedures
Account configuration 
procedures
The final step to making the modem operational is configuring 
it to use your CDMA service provider account. The process of 
activation configures your modem with the required account 
parameters (phone number, username, password, and so on).

If you purchased a pre‐activated modem, this step is not 
necessary. Once the application software and drivers are 
installed, the modem is ready for use. Proceed to “Watcher 
Basics” on page 27.

Otherwise, you must either allow use the Activation Wizard to 
activate and configure your account.

Activation Wizard

The Activation Wizard walks you through the process of 
configuring an account. The process and options vary based on 
the service provider.

This section is a guide only. Consult the Quick Start Guide, and 
follow the directions on screen and instructions given by your 
service provider representative.

If your modem does not have an activated account, and 
Watcher has started automatically, then the Activation Wizard 
should start automatically. If this does not happen:
1. Ensure Watcher is running. If it is not, double‐click the 

Watcher icon   on your desktop.

2. Start the Activation Wizard: select Tools > Activation Wizard.

3. If the Automated Activation option is not available, select 
Manual Activation and go to “Manual activation” on page 26.

4. Select the Automated Activation option.
The activation progress is displayed in the Activation Wiz‐
ard window. If the process is successful, the window dis‐
plays “Activation successful”.
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Note: If the window does not display  “Activation successful”, retry the 
process. If the process continues to fail, use manual activation (below) 
or contact your service provider.

At this point your modem is ready to use.

Proceed to “Watcher Basics” on page 27.

Manual activation

Manual activation involves phoning your service provider, 
exchanging information, and entering your account infor‐
mation into the appropriate fields in the wizard. (To use this 
method, you require a phone.)

Use the Next and Back buttons to navigate through the wizard, 
noting the following:
• Prepare your billing information, before you phone the 

service provider or proceed to the next window.
• Contact your service provider. Inform your service 

provider that you are activating a Sierra Wireless wireless 
device. The representative will request your 
ESN (Electronic Serial Number) or MEID. This is displayed 
in the Activation Wizard (and is printed on the modem 
box and on the label on the back of the modem).

• As prompted by the wizard, enter the information 
provided by the service representative.

• Select Finish in the final window of the wizard.

On completion of the Activation Wizard, the modem is ready 
for use. Proceed to “Watcher Basics” on page 27.
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55: Watcher Basics
• Starting and closing 

Watcher
• Components of the 

Watcher Window
• Interpreting icons
• GPS Monitor window
• Online Help
• Warranty
• Troubleshooting Watcher is the application that allows you to manage and 

monitor the connection between the modem and the CDMA 
network. You use Watcher to:
• Determine your signal strength, roaming status, 3G high‐

speed data availability, and other network connection 
parameters

• Initiate and end data calls
• Use location‐based services (subject to feature availability)
• View call statistics
• Receive and send SMS messages
• Customize features and options

Depending on Watcher settings, you may be able to connect to 
the CDMA network without starting Watcher—simply by 
launching whatever application you want to use (such as your 
web browser or e‐mail application); for details, see the online 
help topic “Autoconnect behaviour”. However, Watcher and 
its icon in the system tray won’t be available for you to monitor 
the status of the connection. Location‐based services also won’t 
be available.

Starting and closing Watcher
Depending on your settings in the Options window, Watcher 
may launch automatically anytime you insert the modem. You 
can also launch Watcher by:
• Double‐clicking the Watcher icon  on your desktop
• Selecting:

In Windows Vista or Windows XP: Start > All Programs > 
Sierra Wireless > Watcher > Watcher;
In Windows 2000: Start > Programs > Sierra Wireless > 
Watcher > Watcher.
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The standard Windows control buttons in the upper right 
corner of the window are used to minimize or close Watcher. 
When minimized, Watcher does not appear as a taskbar 
button. Instead, an icon is shown in the system tray, usually at 
the right end of the taskbar. (See “Minimized icons” on 
page 32.)

Components of the Watcher 
window
The window has three areas that display messages and icons: 
the Connection Status Area (page 30), Call Status Area 
(page 31), and Indicator Area (page 32). These areas are shown 
in Figure 5‐1 that follows.

A menu bar is located on the upper left side of the window.

Windows control buttons are in the top right corner.

Figure 5-1: Watcher window

For a detailed description of each option in the menus, see the 
online help.

Toggle Full/Compact button

Close buttonMinimize button
Menu bar

Connection Status Area

Call Status Area

Indicator area button
Disconnect 
Connect/ 
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Window controls

• The Minimize button closes the Watcher window but leaves 
the application running. When Watcher is minimized, you 
can use the Watcher icon in the system tray to determine 
the modem status. (See “Minimized icons” on page 32.) 
This icon replaces a taskbar button for Watcher.
Once minimized, you can redisplay the Watcher window 
by doing one of the following:
· Clicking the Watcher icon in the system tray
· Double‐clicking the Watcher desktop shortcut
· Launching Watcher from the Start menu.

• The Toggle Full/Compact button   is used to switch 
between the full Watcher window and the compact view:

The compact view allows you to see connection status and 
indicators while using less space on the desktop. If you 
right‐click the compact view, a menu is displayed. From 
this menu you can open some of the other Watcher win‐
dows or establish/end a data connection.
To return to full view, click the view toggle button in the 
top right.

• The Close button   is used to exit Watcher.

Docking

You can set the Watcher window to “jump” to the edge of your 
screen when you move the window close to an edge. This lets 
you easily position Watcher in a corner of the screen.
• Select View > Docking

Always On Top

You can set Watcher to always display in front of other 
windows. This allows you to monitor connection status while 
using another maximized application, such as your web 
browser.
• Select View > Always On Top
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Interpreting icons
Watcher makes extensive use of icons to indicate status and 
events. The various icons are described in the following 
sections on the display areas of Watcher.

Connection Status Area

The Connection Status Area uses the icons shown in the 
following table.

Table 5-1: Connection Status Area icons

Icon Meaning

Modem not detected.

You may be able to resolve this by doing one of the 
following:
- Unlocking the modem (Tools > Unlock Modem)
- Powering the modem on (Tools > Turn Radio On)
- Ejecting the modem and re-inserting it

If this icon is still displayed, restart your computer.

The Signal Strength indicator uses bars to show the 
intensity of the radio signal. The number of bars 
increases as signal strength increases, to a maximum 
of five bars.

When the bars are dimmed and the antenna icon is 
crossed out, no connection is possible for one of these 
reasons:
• You are outside the CDMA network coverage area
• The signal strength is too weak
• A network or account problem is preventing the 

modem from obtaining service

1xEV-DO Rev. A icon.

1xEV-DO Rev. 0 icon.

1X icon.

When only the letters are displayed, you have acquired 
service, but have not established a data connection.

When the indicator has a gray background, the network 
connection is dormant. (You are connected, but there is 
currently no traffic.)

When the indicator has a darker background, you have 
a data connection on the wireless service.
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Call Status Area

The Call Status Area displays messages related to the status or 
progress of a connection.

Where a duration timer is shown, timing begins when the call 
is initiated—not from the time the call is fully connected. This 
is a measure of the time the modem has been using the radio 
channel (a wireless network resource).

“Click this display to exit PowerSave mode” indicates that the 
modem could not find a system within a 15 minute interval. To 
conserve power, the modem reduces channel scanning to once 
every three minutes. To force the modem out of PowerSave 
mode, click in the Call Status Area. The modem performs a 
channel scan and, if no network is detected, returns to 
PowerSave mode.

The Roaming Status indicator shows whether you are 
roaming onto the network of a service provider other 
than your own.

When the indicator is off (gray), you are within the local 
coverage area of your service provider. When the 
indicator is on (solid black), you are roaming.

Your coverage area and account charges depend upon 
your service provider and the type of account you 
have.
There may be surcharges for roaming service.
If there is no roaming agreement between your service 
provider and the local carrier, you may be unable to 
establish data connections and use other features.

Location-based services may not be available 
(depending on the settings of your device, the 
mechanism that the network and your device use to 
obtain location information, and other factors).

Table 5-1: Connection Status Area icons (continued)

Icon Meaning
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Indicator area

The Indicator area displays an icon that notifies you when you 
receive SMS messages, and an icon that reflects the GPS status 
(subject to feature availability; network operator dependent).

Minimized icons

Watcher displays an icon in the Windows system tray (which 
is usually located in the lower right corner of your screen). The 
system tray icon indicates your connection status or notifies 
you when you have SMS messages.

Table 5-2: Indicator Area icons

Icon Meaning

The SMS message indicator shows whether you have 
unread messages. A blinking icon indicates that there are 
one or more urgent or important unread messages.

To display the SMS Express window (in which the 
messages are displayed), select Tools > SMS Express or 
double-click the icon.

If you position the mouse pointer over the GPS icon, the 
ToolTip shows the GPS status (on or off).
Double-click the icon to open the GPS Monitor window 
(page 33).
(Network operator dependent; this icon may not be 
displayed.)

Table 5-3: System tray icons

Icon Meaning

Watcher cannot detect the modem. Ensure that the 
modem is powered on, not locked, and properly 
connected to your computer.

You are in service on the network but have no active data 
connection.
The number of red bars indicates the signal strength.

You have an active data connection.
The number of green bars indicates the signal strength.

You have a new SMS message.
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Only one icon can be displayed at a time. The priority of icons, 
from highest to lowest, is:
• No modem detected
• SMS message(s)
• Active or inactive connection.

For example, if you have unread SMS messages, and then 
establish a data connection, the icon still displays as an unread 
SMS message.

GPS Monitor window
The GPS Monitor window reports GPS data from your 
modem.

The modem must have a fix on at least four satellites to report 
latitude, longitude, altitude, velocity and heading. (The status 
bar at the bottom of the GPS Monitor window indicates how 
many satellites are being tracked.)

To open the GPS Monitor window:
1. In Watcher, select Tools > Display GPS.

‐ or ‐

Double‐click the GPS icon   in the main Watcher 
window (network operator dependent; this icon may not 
be available).

The GPS Monitor window reports:
• Longitude and Latitude — your coordinates in degrees, 

minutes, and seconds.
• Direction — your direction in degrees from true north (0), 

increasing clockwise.
• Speed — calculated based on your current latitude and 

longitude and the last reading (one second previous). This 
is either in kilometers per hour or miles per hour, 
depending on your chosen option.

• Altitude — your altitude relative to mean sea level, in 
either feet or meters, depending on your chosen option.

• HEPE — Horizontal Estimated Position Error. Reflects 
accuracy (horizontal/vertical precision).
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• GPS port — port used for GPS activity.
• Updated — date/time that the GPS values were last 

acquired. The display format is based on your Control 
Panel settings in Windows.

From the GPS Monitor window you can:
• Determine the number of satellites being tracked
• Get your current location
• View a map of your current location
• Start/stop a tracking session
• Configure GPS settings

For detailed information on using GPS and configuring the 
settings, see the online Help of GPS Monitor.

Online Help
The Watcher and GPS Monitor applications include extensive 
online help to provide operating hints and step‐by‐step 
instructions for getting the most from your modem.

You can access online help in several ways:
• Press <F1> in any window.
• Use Windows Explorer to navigate to Program Files > 

Sierra Wireless Inc > Watcher > Help, and double‐click 
Watcher_ENU.chm (for Watcher help) or GPS_ENU.chm (for 
GPS Monitor help).

The help files have a table of contents, an index, and search 
capabilities.

Warranty
You can access a PDF of the warranty, in:
• Windows Vista or Windows XP: Start > All Programs > 

Sierra Wireless > Watcher

• Windows 2000: Start > Programs > Sierra Wireless > Watcher
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Troubleshooting
The online help includes descriptions of most common error 
messages. Look in the table of contents under Troubleshooting.

For help with other problems:
• Consult the Sierra Wireless web site at 

www.sierrawireless.com, where you will find an extensive 
knowledge base that can be searched to address most 
problems.

• Contact your service provider.

http://www.sierrawireless.com
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66: Technical Specifications
• LED operation
• Radio frequency and 

electrical 
specifications

• Environmental 
specifications

This chapter describes the function of the LEDs, and provides 
technical product data for the modem.

LED operation
The modem has two LED lights. The LEDs operate as follows:

Table 6-1: LED operation

LED State Indicates

Off The modem has no power, or the LED has been 
disabled through the software.
Check whether any of the following apply:
• You have powered off the modem.
• The modem is not completely inserted into the 

ExpressCard/PC Card slot.
• The computer is in suspend mode, which powers 

down the modem.
• You have set Disable LED (under Tools > 

Options > General) to “Yes” (subject to feature 
availability).

Blue, not 
blinking

The modem has power and is working properly.

Blue, 
blinking

The modem’s firmware is being updated. Do not 
remove the modem.
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Radio frequency and electrical 
specifications

Amber, 
blinking

The modem is searching for service.
If this LED state persists:
• Ensure the modem is properly connected to your 

computer.
• If you are inside a building or near a structure 

that may be blocking the signal, change the 
position or location of your computer.

• You may be able to improve the signal strength 
by attaching an external antenna (page 23).

• Ensure you are within the CDMA network 
coverage area. For coverage information, 
contact your service provider.

• Check with your service provider—a network or 
account problem may be preventing the wireless 
device from obtaining service.

Amber, not 
blinking

An error has occurred. Remove the modem (page 23) 
and reinsert it.

Off No service is available.
See the suggestions for “Amber, blinking” on 
page 38.

Amber, 
blinking

1X coverage is detected. Ready to connect to the 
network (click Connect).

Amber, not 
blinking

The modem is connected to the 1X network, and can 
send or receive data.

Blue, 
blinking

1x-EVDO coverage (Rev. 0 or Rev. A) is detected. 
Ready to connect to the network (click Connect).

Blue, not 
blinking

The modem is connected to the 1x-EVDO network, 
and can send or receive data.

Table 6-1: LED operation (continued)

LED State Indicates

Table 6-2: Radio frequency and electrical 
specifications

Approvals Compliant with:
IS-2000 Release 1.0 (CDMA 1X)
IS-707-A Data, IS-856 (CDMA 1x-EVDO), IS-866, 
IS-878, IS-890, CDMA Development Group
FCC
Industry Canada

Voltage +3.3 Vdc from ExpressCard or PC Card slot
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Environmental specifications

Current Maximum: 1300 A
Typical data call current (talk mode):

350 mA (1X)
430 mA (1xEV-DO)

Standby: 100 mA (1xEV-DO/IS2000 hybrid 
mode)

Transmitter 
power

200 mW (+23 dBm) average

Transmit PCS: 1850 to 1909.95 MHz
Cellular: 824.04 to 848.97 MHz

Receive PCS: 1930 to 1989.95 MHz
Cellular: 869.04 to 893.97 MHz
GPS: 1575.42 MHz

Channel 
spacing

1.25 MHz

Frequency 
stability

±150 Hz

Table 6-3: Environmental specifications

Operating 
temperature

-20 to +55°C (ambient, outside PCMCIA 
enclosure)

Storage 
temperature

-40 to +85°C 

Humidity 95%, non-condensing

Vibration Random vibration, 10 to 1000 Hz, nominal 6G 
RMS in each of 3 mutually perpendicular axes. 
Test duration of 60 minutes for each axis, for a 
total test time of 3 hours (non-operating).

Drop 1 m on concrete on each of 6 faces, 2 times

Table 6-2: Radio frequency and electrical 
specifications (continued)
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77: Regulatory Information
• Important safety/

compliance 
information

• Information pertaining 
to OEM customers

Important safety/compliance 
information
The design of the AirCard 402 modem complies with U.S. 
Federal Communications Commission (FCC) and Industry 
Canada (IC) guidelines respecting safety levels of radio 
frequency (RF) exposure for portable devices, which in turn 
are consistent with the following safety standards previously 
set by Canadian, U.S. and international standards bodies:
• ANSI / IEEE C95.1‐1999, IEEE Standard for Safety Levels with 

Respect to Human Exposure to Radio Frequency Electromag‐
netic Fields, 3kHz to 300 GHz

• National Council on Radiation Protection and Measure‐
ments (NCRP) Report 86, ‐1986, Biological Effects and 
Exposure Criteria for Radio Frequency Electromagnetic Fields

• Health Canada, Safety Code 6, 1999, Limits of Human 
Exposure to Radio frequency Electromagnetic Fields in the 
Frequency Range from 3 kHz to 300 GHz

• International Commission on Non‐Ionising Radiation 
Protection (ICNIRP) 1998, Guidelines for limiting exposure to 
time‐varying electric, magnetic, and electromagnetic fields (up 
to 300 GHz)

FCC ID: N7NAC402.

CAUTION: The AirCard 402 modem must be 1.2 cm or more 
from users during operation, to satisfy FCC RF exposure 
requirements. It is recommended to use the AirCard 402 
modem in a PC Card slot whenever possible. If the laptop 
computer has two slots, it is recommended to use the upper 
slot for optimum modem performance. When the AirCard 402 
modem is inserted into the laptop computer during lap held 
usage, it is recommended that the antenna portion of the 
AirCard 402 modem be moved away from the leg to ensure the 
maximum data rate is available to the user. The AirCard 402 
modem has been tested for compliance with FCC / IC RF 
exposure limits in the laptop computer(s) configurations with 
the side loading ExpressCard or PC Card slot and can be used 
in laptop computers with substantially similar physical dimen‐
sions, construction, and electrical and RF characteristics. This 
modem must not be used with any other antenna or trans‐
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mitter that has not been approved to operate in conjunction 
with this modem. Note: This modem must not be used in any 
unapproved configurations. For details, contact Sierra 
Wireless.

Use of this device in any other configuration may exceed the 
FCC RF Exposure compliance limit. Note: If this modem is 
intended for use in any other portable device, you are respon‐
sible for separate approval to satisfy the SAR requirements of 
Part 2.1093 of FCC rules.

WARNING (EMI) - United States FCC Information ‐ This equipment 
has been tested and found to comply with the limits for a 
Class B computing device peripheral, pursuant to Part 15 of 
the FCC rules. These limits are designed to provide reasonable 
protection against harmful interference in a residential instal‐
lation.

This equipment generates, uses, and can radiate radio 
frequency energy and, if not installed and used in accordance 
with the instructions, may cause harmful interference to radio 
communications. However, there is no guarantee that inter‐
ference will not occur in a particular installation.

If this equipment does cause harmful interference to radio or 
television reception, which can be determined by turning the 
equipment off and on, the user is encouraged to try to correct 
the interference by one or more of the following measures:
• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and 

receiver.
• Connect the equipment into an outlet on a circuit different 

from that to which the receiver is connected.
• Consult the dealer or an experienced radio/TV technician 

for help.

This device complies with Part 15 of the FCC Rules. Operation 
is subject to the condition that this device does not cause 
harmful interference.

CAUTION: Any changes or  modifications not expressly 
approved by Sierra Wireless could void the user’s authority to 
operate the equipment.

WARNING (EMI) - Canada ‐ This digital apparatus does not 
exceed the Class B limits for radio noise emissions from digital 
apparatus as set out in the interference causing equipment 
standard entitled ʺDigital Apparatusʺ, ICES‐003 of the 
Department of Communications.
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Cet appareil numérique respecte les limites de bruits radioélec‐
triques applicables aux appareils numériques de Classe B 
prescrites dans la norme sur le matériel brouilleur: ʺAppareils 
Numériquesʺ, NMB‐003 édictée par le ministre des Communi‐
cations.

If you have purchased this product under a United States 
Government contract, it shall be subject to restrictions as set 
forth in subparagraph (c)(1)(ii) of Defense Federal Acquisitions 
Regulations (DFARs) Section 252.227‐7013 for Department of 
Defense contracts, and as set forth in Federal Acquisitions 
Regulations (FARs) Section 52.227‐19 for civilian agency 
contracts or any successor regulations. If further government 
regulations apply, it is your responsibility to ensure 
compliance with such regulations.

Information pertaining to OEM customers

The AirCard 402 modem has been granted modular approval 
for mobile applications. Integrators may use the AirCard 402 
modem in their final products without  additional FCC / IC 
certification if they meet the following conditions. Otherwise, 
additional FCC / IC approvals must be obtained.
1. At least 20 cm separation distance between the antenna 

and the user’s body must be maintained at all times.
2. To comply with FCC / IC regulations limiting both 

maximum RF output power and human exposure to RF 
radiation, the maximum antenna gain must not exceed 
5.2 dBi in the Cellular band and 3.75 dBi in the PCS band.

3. The AirCard 402 modem and its antenna must not be 
colocated with any other transmitter or antenna within a 
host device.

4. A label must be affixed to the outside of the end product 
into which the AirCard 402 modem is embedded, with a 
statement similar to the following:
This device contains TX FCC ID: N7NAC402.
This equipment contains equipment certified under IC: 
2417C-AC402.

5. A user manual with the end product must clearly indicate 
the operating requirements and conditions that must be 
observed to ensure compliance with current FCC / IC RF 
exposure guidelines.

6. The end product with an embedded AirCard 402 modem 
must pass the unintentional emission testing and properly 
authorized per FCC Part 15 requirements.
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Note: If this modem is intended for use in a portable device, you are 
responsible for separate approval to satisfy the SAR requirements of 
FCC Part 2.1093 and IC RSS-102.
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AAppendix A: Glossary
1X One Times Radio Transmission Technology (the ʺone timesʺ 

refers to the frequency spectrum). Supports Internet 
connections with data rates up to 153 Kbps. Actual speed 
depends on the network conditions. Compare to 1x‐EVDO.

1x-EVDO A high‐speed standard for cellular packet data communica‐
tions. 

Rev. A supports Internet connections with data rates up to 
3.1 Mbps (downlink from the network) and 1.8 Mbps (uplink 
to the network).

Rev. 0 supports Internet connections with data rates up to 
2.4 Mbps (downlink from the network) and 153 Kbps (uplink 
to the network). 

Average data rates are: for Rev. A: 450–800 Kbps (downlink 
from the network) and 300–400 Kbps (uplink to the network); 
for Rev. 0: 400‐700 Kbps (downlink from the network) and 
40‐80 Kbps (uplink to the network).

Actual speed depends on the network conditions. Compare to 
1X.

bps bits per second—The actual data speed over the transmission 
medium.

CDMA Code Division Multiple Access—A wideband spread spectrum 
technique used in digital cellular, personal communications 
services, and other wireless networks.  Wide channels 
(1.25 MHz) are obtained through spread spectrum transmis‐
sions, thus allowing many active users to share the same 
channel. Each user is assigned a unique digital code, which 
differentiates the individual conversations on the same 
channel.

CDMA 1X Also known as 1X, this is a high‐speed standard for CDMA 
cellular communications.

dormant The packet data connection has the logical PPP session left 
open while the underlying physical link (the radio channel) is 
released. When traffic is to resume, a radio channel is 
re‐acquired and the original PPP session resumes.

ESN Electronic Serial Number—The unique first‐generation serial 
number assigned to the modem for cellular network use. 
Compare to MEID.

ExpressCard™ Add‐in memory and communications cards for portable 
computers. ExpressCard is a trademark of the PCMCIA.
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FCC Federal Communications Commission—The U.S. federal 
agency that is responsible for interstate and foreign communi‐
cations. The FCC regulates commercial and private radio 
spectrum management, sets rates for communications services, 
determines standards for equipment, and controls broadcast 
licensing.  Consult www.fcc.gov.

firmware Software stored in ROM or EEPROM; essential programs that 
remain even when the system is turned off.  Firmware is easier 
to change than hardware but more permanent than software 
stored on disk.

GPS Global Positioning System—A system that uses a series of 24 
geosynchronous satellites to provide navigational data.

host • A computer that uses a modem or a similar device to 
answer a calling computer.

• A source or destination in the communication network.
• A computer that contains data or files to be accessed by 

client computers.  Also known as a server.

IS Interim Standard—After receiving industry consensus, the TIA 
forwards the standard to ANSI for approval.

IS-95 The standard for CDMA.

Kbps Kilobits per second—Actually 1000, not 1024, as used in 
computer memory size measurements of kilobytes.

LAN Local Area Network

LED Light Emitting Diode—A semiconductor diode that emits 
visible or infrared light.

MEID Mobile Equipment Identifier—The unique second‐generation 
serial number assigned to the modem for cellular network use. 
Compare to ESN.

Mbps Megabits per second

MHz Mega‐Hertz—One million cycles per second.

packet A short fixed‐length block of data, including a header, that is 
transmitted as a unit in a communications network.

PC Card™ Add‐in memory and communications cards for portable 
computers. PC Card is a trademark of the PCMCIA.

PCMCIA Personal Computer Memory Card International Association—
The organization that standardizes ExpressCards and 
PC Cards.

PCS Personal Communications Services—A cellular 
communication infrastructure that uses a different frequency 
range than AMPS.

http://www.fcc.gov
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roaming A cellular subscriber is in an area where service is obtained 
from a cellular service provider that is not the subscriber’s 
provider.

SMS Short message services—A feature that allows users of a 
wireless device on a wireless network to receive or transmit 
short electronic alphanumeric messages (up to 160 characters, 
depending on the service provider).

system tray Usually located in the lower right corner of your screen

TIA Telecommunications Industry Association—A standards‐
setting trade organization, whose members provide 
communications and information technology products, 
systems, distribution services and professional services in the 
United States and around the world. Consult www.tiaonline.org.

VPN Virtual Private Network

http://www.tiaonline.org
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Windows (indicator in system tray),  32

connection status area,  30
contact information,  4
coverage

description,  14
CSD (circuit switched data)

description,  12
current location

get,  34
map of,  34

D

data
circuit switched ‐ description,  12
dial‐up ‐ description,  12
high‐speed,  11
QNC,  12

dial‐up data
description,  12

direction,  33
docking,  29
dormant,  30
drivers

description,  13
driving instructions,  10
drop test,  39

E

electrical specifications,  38
Electronic Serial Number (ESN)

description,  18
EMI warning,  42
environmental specifications,  39
ESN (Electronic Serial Number)

description,  18
EVDO

description,  11
icon,  30
LED ‐ coverage is detected,  38

expanded (full) view
description,  28
toggle button,  29

external antenna,  23

F

FCC
compliance,  42
ID,  41

firmware upgrades,  4
frequency bands, CDMA network,  13
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full view
description,  28
toggle button,  29

G

GPS
overview,  10
GPS Monitor window,  33
icon,  32
port number, GPS,  34

GPS Monitor window,  33

H

hardware
modem, removing,  23

hazards,  2
help, online,  34
help, troubleshooting,  35
HEPE (Horizontal Estimated Position Error),  33
high‐speed packet data,  11
Horizontal Estimated Position Error (HEPE),  33
humidity,  39

I

icons
connection status,  30
coverage,  30
GPS,  32
indicator area,  32
minimized,  32
roaming,  31
SMS messages,  32
system tray,  32
See also indicators.

ID, FCC,  41
ID, Industry Canada,  38
indicator area,  32
indicators

connection status,  32
GPS,  32
LED lights,  37
roaming,  31
SMS messages,  32
See also icons.

Industry Canada ID,  38
installation,  19
interference,  42
Internet,  11

K

knowledge base,  35

L

latitude,  33
LBS (location based services)

See GPS.
LED lights,  37
liability, limitation of,  3
limitation of liability,  3
location based services (LBS)

See GPS.
location, current

get,  34
map of,  34

longitude,  33

M

map of your current location,  34
MEID (Mobile Equipment Identifier),  18
messaging, text

See SMS.
minimize button,  29
minimized icons,  32
Mobile Equipment Identifier (MEID),  18

N

no service,  38
notices, regulatory,  41
number of satellites being tracked,  34

O

OEM customers,  43
online Help,  34
operating hints,  34
operating systems supported,  19
operating temperature,  39

P

packet data, high‐speed,  11
POI (points of interest),  10
points of interest (POI),  10
port, GPS,  34
PowerSave mode,  31
pre‐activation,  17

Q

QNC,  12
Quick Net Connect (QNC),  12

R

radio frequency specifications,  38
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regulatory information,  41
requirements, system,  19
roaming

definition,  14
indicator,  31

S

safety,  2
sales desk,  4
satellites being tracked, number of,  34
searching for service,  38
service indicator,  32
short text messaging

See SMS.
signal strength, CDMA network,  30
SMS

message indicator,  32
software

overview,  13
installing,  19
using,  27

specifications
electrical,  38
environmental,  39
radio frequency,  38

speed of travel,  33
status area

call status area,  31
connection status area,  30
indicator area,  32
Windows system tray,  32

storage temperature,  39
support,  35
suspend mode,  37
system requirements,  19
system tray icons,  32

T

taskbar icons,  32
temperature,  39
text messaging

See SMS.
tips, operating,  34
tracking session,  34
traveling speed,  33
troubleshooting,  35
TRU‐Install,  10
TRU‐Locate,  10

See also GPS.

U

upgrades, firmware,  4

V

vibration,  39
Virtual Private Network (VPN),  9
Vista,  19
VPN (Virtual Private Network),  9

W

warning
EMI,  42

warranty,  34
Watcher software

overview,  27
installing,  19
using,  27

Windows
system tray icons,  32
versions supported,  19

Windows Vista,  19
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